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0. General requirements
This document was prepared using the Physical Mesomechanics template for Microsoft Word. It provides a simple example of an article and offers guidelines for preparing your article. 
You can edit or delete the content provided in this template and replace it with the text and figures of your article. You can also apply a required style to a paragraph, click anywhere in the paragraph text then click on the appropriate style listed in the Styles window in this template.
Important: In case of non-conformity to the above requirements the article is returned to the authors without consideration. 
For publication in Physical Mesomechanics journal an article must be written in good English. 
Spelling and grammar checks have been carried out. Manuscripts with a low level of English are returned without explanation.
For authors who would like their manuscript to receive language editing or proofreading to improve the clarity of the manuscript and help highlight their research, we recommend using language-editing services.
Note that sending your manuscript for language editing does not imply or guarantee that it will be accepted for publication by the Physical Mesomechanics journal. Editorial decisions on the scientific content of a manuscript are independent of whether it has received language editing or proofreading by other services.
For publication in Fizicheskaya Mezomekhanika (the Russian version of the Physical Mesomechanics journal), an article should be written in Russian. 
The electronic version of a manuscript should include files that contain all elements of an article (text, tables, and illustrations) in DOCX and PDF formats.
Due to some cross-platform compatibility issues, the following rules must be adhered to prior to preparing your files. 
(1) All files must be edited in Microsoft Word 2007 or later. 
(2) In Microsoft Office, Autosave must be turned off in the Options submenu. The Autosave function makes least-common-denominator fixes when it encounters compatibility problems, primarily, converting MathType or Equation objects into Picture objects. 
(3) Files should during the course of work be saved periodically by depressing the disk icon in the ribbon or by choosing Save in the File menu. The main aim of both points is to preserve the editability of MathType and Equation objects at the production stages; if formulas are converted into Picture objects, this property is lost and the file becomes unusable.
Important: The predefined styles are to be used. All parts of the manuscript (title, authors, affiliations, abstract, keywords, headings, text, figures, figure captions, tables, table captions, equations, references, etc.) must use a suitable style. The styles are described here, but they are available in this file, in the list of styles. The styles define the spacing to surrounding manuscript elements (before and after) and, hence, empty lines should not be inserted. The authors should be aware that the failure to use the proper styles and therewith to properly format the manuscript would postpone processing of the submission.
The minimum length of a manuscript, taking account for all its elements, should be not less than 10 journal pages for original articles and 16 journal pages for a review.
Please use only these standard fonts: Times New Roman for text, Symbol for Greek symbols.
Permission has been obtained for the use of any copyrighted material (figures, data, etc.) from other sources, including the Web.
The use of abbreviations should be kept to a minimum. Non-standard abbreviations should be avoided unless they appear at least five times, and must be defined upon first use in the main text. Consider also giving a list of non-standard abbreviations at the end, immediately before the acknowledgments. 
There should not be periods after manuscript title, list of authors, affiliations, keywords, section headings and subheadings, table titles and most of the units of measure.
Use periods rather than commas in decimals (correct: 0.25, incorrect: 0,25).
All references in the article text must appear in the reference list and vice versa. References should be numbered in order of appearance and indicated by a numeral or numerals in square brackets—e.g., [1] or [2, 3], or [4–6]. Do not cite large groups of articles (more than 5 articles) without individually commenting on them (e.g. "In early work [1–8] ...".).
1. introduction 
Main heading (STYLE HEADING_1: ALL CAPS, 11 pt, CENTERED, SPACING BEFORE 18 pt, 
SPACING AFTER 6 pt, KEEP WITH NEXT, KEEP LINES TOGETHER)
The introduction should briefly place the study in a broad context and highlight why it is important. It should define the purpose of the work and its significance. The current state of the research field should be carefully reviewed and key publications cited. As far as possible, please keep the introduction comprehensible to scientists outside your particular field of research. 
It is recommended to provide references to at least 20 literature sources reflecting the state-of-the art of the problem in the world. At least 50% of references must be to articles published in the last 5 years. Excessive self-citation (more than 15%) should be avoided. Avoid citing textbooks and study guides.
2. MAIN TEXt
Main heading (STYLE HEADING_1: ALL CAPS, 11 pt, CENTERED, SPACING BEFORE 18 pt, 
SPACING AFTER 6 pt, KEEP WITH NEXT, KEEP LINES TOGETHER)
Main text (style Text): Use only characters and symbols available in the Times New Roman or Symbol font, 11 pt; paragraph format: justified alignment, left and right indent 0 pt, space before and after 0 pt. First line of the paragraph should be indented 0.75 cm. For Letter (8.5" by 11" (215.9 by 279.4 mm)) paper size, margins should be 2 cm top and right, 2.4 cm bottom, 2.5 cm left.
Main text is divided into subheadings for research articles and reviews. Subheadings should be descriptive clauses, not full sentences. Three levels of subheadings may be used if warranted; please distinguish them clearly (see examples below). 
Symbols, abbreviations, and acronyms should be defined the first time they are used. All tables and figures should be cited in numerical order.
Footnotes should be avoided if additional information may be included in the text.
2.1 Headings and Subheadings
First-Level Subheading (Style Heading_2: 11 pt Italic, 
Capitalize the First Word and Proper Noun, Centered, Spacing Before 12 pt, Spacing After 6 pt, 
Keep with Next, Keep Lines Together)
A maximum of three heading levels is allowed (HEADING_1, Heading_2, Heading_3). Headings of sections within the text should be written in all capitals. First-level subheadings should be italicized and the first word and proper noun should be capitalized. Second-level subheadings (i.e., headings run into a paragraph) should follow sentence capitalization with the first word capitalized, and are italicized. 
2.2 Units of Measure
First-Level Subheading (Style Heading_2: 11 pt Italic, 
Capitalize the First Word and Proper Noun, Centered, Spacing Before 12 pt, Spacing After 6 pt, 
Keep with Next, Keep Lines Together)
Use the International System of Units (SI) for physical quantities and units of measurement. If you do not use these exclusively, provide the SI value in parentheses after each value. A period is not used in abbreviated units of measure. Seconds should be abbreviated as “s”, not “sec”; minutes should be abbreviated as “min”; and hours should be abbreviated as “h”.
Units of measure are separated from numbers by a non-breaking space: 17.5 mol %, 77 K, 10.34 Å, 58 J/mol, 50 m/s2. Exceptions are: 90°, 20°C, 50%, 10‰. Non-breaking spacea space character that prevents an automatic line break at its position. To insert a non-breaking space in Word, press Ctrl + Shift + Space.
There are various ways of rendering complex units of measure; however, the selected way must be consistent throughout the manuscript: J mol1 K1, J/(mol K), and J (mol K)1.
In ranges and series, retain only the final unit of measure (10–12 mg; 5, 10, and 20 kV; 25–30%; 30, 60, and 90°C). The degree when it indicates angles sign is an exception.
Degrees Celsius should be °C rather than °. The latter refers to angles.
2.3 Spaces
First-Level Subheading (Style Heading_2: 11 pt Italic, 
Capitalize the First Word and Proper Noun, Centered, Spacing Before 12 pt, Spacing After 6 pt, 
Keep with Next, Keep Lines Together)
There should be non-breaking spaces in table, figure and equation callouts: Fig. 1, Table 2, Eq. (1).
There should not be spaces between quotation marks or parentheses and text included in them.
Numbers with letters should be rendered without spaces, e.g., Fig. 1a.
In longitudes and latitudes there should be spaces: 56.5° N; 85.0° E.
Mathematical symbols should be separated by a space only when there are units on both the left- and right-hand sides, but without a space when a unit appears only on the right, for example: 100 ± 2; by a factor of 2.
2.4 Guidelines for Presenting Mathematical Information
First-Level Subheading (Style Heading_2: 11 pt Italic, 
Capitalize the First Word and Proper Noun, Centered, Spacing Before 12 pt, Spacing After 6 pt, 
Keep with Next, Keep Lines Together)
An Equation Editor or MathType Equation Editor is to be used in the main text only if symbols are needed (when explaining terms from equations, for instance) that are not available as plain text or symbols.
Equations should be prepared using the MathType Equation Editor or an Equation Editor integrated in Word.
Important: The authors should avoid using an Equation Editor directly in the text (e.g. when they explain terms/quantities used in the equations). Plain text and Insert→Symbols should be used instead. Only if no adequate symbols are available, an Equation Editor is to be used directly in the text.
We recommend using MathType for display and inline equations, as it will provide the most reliable outcome. If this is not possible, Equation Editor or Microsoft's Insert→Equation function is acceptable.
For MathType formulas, standard font settings should be used. Do not change these settings for any element of a formula.
Avoid using MathType, Equation Editor, or the Insert→Equation function to insert single variables (e.g., a2 + b2 = c2), Greek or other symbols (e.g., , β, Δ, or ′, , *), or mathematical operators (e.g., ≥ or ±) in running text. Wherever possible, insert single symbols as normal text using Insert→Symbols.
Subscripts and superscripts for inline equations should be staggered. Space within subscripts and superscripts should be minimized and used only to avoid misunderstanding: Xb2, tpz−1, xcosx.
Do not use MathType or Equation Editor for only a portion of an equation. Rather, ensure that the entire equation is included. Equations should not contain a mix of different equation tools. Avoid “hybrid” inline or display equations, in which part is text and part is MathType, or part is MathType and part is Equation Editor.
Equations should be centered with equation numbers on the right-hand side (flush right) with unique numbers for all equations. You can copy, paste, and edit the sample equation provided (recommended), or manually insert an equation and equation number.



[bookmark: MTBlankEqn]	,  	(1)
where c — proportionality coefficient; w — speed; bg(s) — function. The text following an equation need not be a new paragraph. Please punctuate equations as regular text.
Equations should not contain extraneous text information that is not part of the equation itself. To cite an equation in text, use the abbreviation “Eq.” (Eq. (1) for example) if it is not the first word in the sentence. Spell out “Equation” when it is the first word of a sentence or when it is not accompanied by a number. The plural of “Eq.” is “Eqs.”. 
Physical Mesomechanics mathematical style conventions to maintain consistency and clarity with respect to character style, spacing, numbering, abbreviations, and units of measure. 
Examples are given in the following:
Italic type (11 pt Times New Roman Italic)
 variables: T for temperature, P for pressure, x for coordinate,
axes: x axis, Y axis
 planes: ab plane,
 components of vectors and tensors: a1 + b1, 
 elements of determinants and matrices: gn,
 constants: kB, the Boltzmann constant,
[bookmark: _Hlk197951940] functions: f(x), F(x),
– variable subscripts and superscripts σij.
Important: Greek symbols are not italicized

Roman (11 pt Times New Roman)
 numerals: 1, 2, 3, ...,
 equation punctuation and enclosing marks: (a, b),
 most operators: +, , >, <, etc.,
 units of measure and time: cm, K, kg,
 nonvariable subscripts and superscripts: mc for critical mass.

Boldface type (11 pt Times New Roman Bold)
 vectors: x = a + b,
 tensors: τ = [1, 2, 3],
 matrices: .
Important: The use of Cyrillic characters in formulas is not allowed.
Long equations should typically be broken before an operator. Equations should not be broken after integral, product, and summation signs; after trigonomic and other functions set in roman type; or before derivatives.

		

		(2)

		(3)
[bookmark: _Hlk197946284]2.5 Requirements for Figures
First-Level Subheading (Style Heading_2: 11 pt Italic, 
Capitalize the First Word and Proper Noun, Centered, Spacing Before 12 pt, Spacing After 6 pt, 
Keep with Next, Keep Lines Together)
Important: The quality of the illustrations in Physical Mesomechanics depends on the quality of the originals provided by the authors. Figures are not modified or enhanced by the journal production staff.
Graphs and diagrams should be prepared in vector graphics editors. Do not add shading or grids to the background of graphs.
Vector illustrations should not have dotted fill patterns like Noise, Black&White Noise, and Top Noise.
Please use only these standard fonts: Times New Roman for text, Symbol for Greek symbols. All fonts should be embedded in a file. 
The figures should be embedded directly in the text of the submitted manuscript. Figures should be placed in the main text near to the first time they are cited (Fig. 1). 
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	Fig. 1. This is a figure with 1 panel. All inscriptions in figures should be given in English. Style Figure_Caption, 9 pt, spacing before 6 pt, spacing after 12 pt, keep with next, keep lines together. [footnoteRef:2] [2:  If the caption for a figure exceeds one line, the 'Justify' alignment option should be used. If the caption fits on a single line, then the 'Center alignment' option should be selected.] 



Figures should be called out within the text and numbered in the order of their citation in the text. 
To cite a figure in text, use the abbreviation “Fig.” (Fig. 1, Fig. 2b for example) if it is not the first word in the sentence. Spell out “Figure” when it is the first word of a sentence or when it is not accompanied by a number. The plural of “Fig.” is “Figs.”. 
For figures with more than one panel, panels should be clearly indicated using labels (a), (b), (c), (d), etc. (Figs. 2, 3). However, do not embed the part labels over any part of the image. If there are multiple panels, they should be listed as: “A general description of a figure: description of what is contained in the first panel (a); description of what is contained in the second panel (b), etc.”. 
	[image: C:\Users\martin\Downloads\testFigure.tif]
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	(a)
	(b)

	Fig. 2. This is a figure with 2 panels: description of what is contained in the first panel (a); description of what is contained in the second panel (b). All inscriptions in figures should be given in English.
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	(a)
	(b)
	(c)

	Fig. 3. This is a figure with 3 panels. All inscriptions in figures should be given in English.


Keep text in the illustrations themselves to a minimum but explain all symbols and abbreviations used. Text should usually be limited to the labeling of axis (including units), arrows, and diagram legends. Long phrases or sentences should be avoided. 
All inscriptions in figures are given in English (including notations of the axes of graphs, scale markers of microstructures, etc.). 
Use scale bars in place of, or in addition to, magnifications. Do not use minor tick marks in scales or grid lines. Scale markers should be presented in a uniform manner. Scales or axes should not extend beyond the range of the data plotted.
Label graphs on the ordinate and abscissa with the parameter or variable being measured, the units of measure (after comma, not in parentheses), and the scale., e.g., Pressure, MPa; Temperature, 102 K. 
Use lettering that will be 9 pt for main labels and 7 pt for subscripts and superscripts at final size. Avoid wide variation in type size within a single figure. In laying out information in a figure, the objective is to maximize the space given to presentation of the data.
2.5.1. Image size and resolution requirements
Second-level subheading (style Heading_3: 11 pt, italic, 
Capitalize the first word only, centered, spacing before 12 pt, after 6 pt, keep with next, 
keep lines together)
Figures should be prepared with the PDF layout in mind. Individual figures should not be longer than one page. The text should be legible and of high quality. The smallest visible text should be no less than 8 pt in height when viewed at final size. The largest text should be no more than 10 pt. 
Any lines in the graphic should be no smaller than 0.5 points wide.
Vector illustrations should have a resolution of 600 dpi. Halftone illustrations should have a resolution of 300 dpi. Combined Halftone/Line drawings should have a resolution of 600 dpi.
The following formats are accepted: TIFF, JPG, and PNG. 
Physical Mesomechanics is published in black and white (print version) and in color (online version).
For color illustrations that will be printed as black and white illustrations without additional editing, the following requirements should be met:
1. The choice of colors for lines and objects should exclude the loss of information when printed in black and white. It is recommended to print color illustrations on a black and white printer and check if objects with different colors are distinguishable. Avoid references to colors in figure captions.
2. Colored lines on graphs and diagrams should be additionally marked with letters, symbols, or numbers, or else the style of lines should be different.
3. Colored regions should also be marked with different symbols rather than similar symbols of different colors.
4. If different colors of the same brightness are adjacent, it is desirable to identify their border with a thin line.
5. When there are many colored regions with similar color tones in the figure, they should be additionally marked with symbols or hatching.
6. It is preferable to make all inscriptions either black or white depending on the background. 
7. Color images must be submitted in the color mode CMYK and 8 bit/channel mode.
Important: Figures from other sources should be fully acknowledged in the caption, and written permission sought for both print and electronic reproduction before being used (where relevant).
2.5.2. Figure captions 
Second-level subheading (style Heading_3: 11 pt, italic, 
Capitalize the first word only, centered, spacing before 12 pt, after 6 pt, keep with next, 
keep lines together)
Ensure that each illustration has a caption. A caption should comprise a brief title (not on the figure itself) and a description of the illustration. Nomenclature, abbreviations, symbols, and units used in a figure should match those used in the text.
In a figure caption, letters or numbers identifying panels of the figure or items within the figure should be in parentheses: 
“Fig. 1. Absorption spectra of pure alkali–calcium silicate glasses (1) and the same glasses activated with 0.2 mol % Eu2O3 (2) with sodium (a) and lithium (b) as modifier”.
Note how curves, spectra, etc., are treated in captions when specifically referred to as such. Also, note that parentheses are not used to refer to a panel of a figure or an item within a figure, graph, photograph, etc., within text: “As can be seen from Figs. 2a–2c, this process leads to increasing instability.  Curve 1 shows the transition most clearly. This transition is shown in Fig. 1a (curve 1).”
2.6 Table Requirements and Style Guidelines
First-Level Subheading (Style Heading_2: 11 pt Italic, 
Capitalize the First Word and Proper Noun, Centered, Spacing Before 12 pt, Spacing After 6 pt, 
Keep with Next, Keep Lines Together)
The tables should be embedded directly in the text of the submitted manuscript. Tables should be called out within the text and numbered in the order of their citation in the text. Please submit tables as editable text and not as images. Please use only these standard fonts: Times New Roman for text, Symbol for Greek symbols. To cite a table in text, use the following form: (Table 1). Number tables consecutively in accordance with their appearance in the text and place any table notes below the table body. All tables should have a heading.
	

	Table 1. EDS data corresponding to the results in Fig. 1b (style Table_Headings, 9 pt, spacing before 0 pt, spacing after 0 pt, keep with next, keep lines together)

	Element
	wt %
	at %

	B(K)
	09.85
	36.45

	Co(K)
	33.27
	22.58

	


An empty line (see examples below) should be left before and after tables.
Tables should have descriptive captions at the top of each table. Please avoid using vertical rules and shading in table cells. The text should have the size (9 pt) as in examples below.
	

	Table 2. Formation energy (eV) of point defects and their complexes in the titanium nitride

	Supercell
	Optimization
	VN
	OI
	ON
	VN + ON
	NI

	(2 × 2 × 2)
	Atomic sites
	2.39
	2.45
	–1.77
	0.70
	5.44

	
	Complete
	2.39
	2.23
	–1.77
	0.70
	5.21

	(3 × 3 × 3)
	Atomic sites
	2.34
	2.33
	–1.79
	0.66
	5.30

	
	Complete
	2.34
	2.26
	–1.79
	0.66
	5.22

	


Large tables should not be wider and longer than one page. Tables which are not according to the above guidelines will cause substantial delay during the production process.
	

	Table 3. Physical and mechanical characteristics of the structural elements of concrete*

	
	Density 
ρ, kg/m3
	Bulk modulus 
K, GPa
	Shear modulus 
μ, GPa
	Cohesion, 
MPa
	α
	Λ
	γ*
	γd
	h
	σ*, 
MPa

	Cement mortar
	2390
	0.2167*
	0.1625
	10
	0.3
	0.05
	0.001
	0.006
	0.06
	2

	Inclusions*
	2750
	0.4000
	0.2900
	100
	–
	–
	–
	–
	–
	30

	Reinforcement
	7860
	1.2821
	0.8064
	300
	–
	–
	–
	–
	–
	300

	*Tables may have a footer.


3. Conclusions
Make sure your conclusions reflect on the strengths and weaknesses of your work, how others in the field can benefit from it and thoroughly discuss future work. 
Conclusions should be different in content from the abstract, and generally should be longer too.
Appendices
An appendix or appendices appear between the end of the main text and the beginning of the ACKNOWLEDGMENTS section, or at the beginning of the REFERENCES section if there are no ACKNOWLEDGMENTS. 
If there is more than one appendix, they should be designated with consecutive letters (APPENDIX A, APPENDIX B, APPENDIX C, etc.). Equations appearing in an appendix should be numbered sequentially, preceded by the letter of the given appendix, for example, (A.1), (A.2); (B.1), (B.2); etc.  If there is only one appendix, numbering of equations should be preceded by the letter “A”; however, the section heading will appear as “APPENDIX” with no letter designation.
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